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1 Overview 
 
This document covers the features and functions that make up Create2000. This 
document does not cover how to build a Master or Scenario database for 
simulation or how to build a database for airspace modeling. That information 
can be found in the Building a Database document. 
 
Create2000 is a component of the SIGNAL software system of air traffic 
simulations written by AMI-800 in support of the FAA Academy in Oklahoma City, 
Oklahoma.  
 

2 Web Site 
 
Information about Create2000 and the other components of the SIGNAL 
software system can be found on our web site @ WWW.SIGNAL.JCCBI.GOV. 
 

3 Database Concept 
 
There are two types of files that Create2000 is capable of loading and creating. 
They are a Master and a Scenario. 
 

Master  A master database is capable of holding all the data types 
that are found in the Data Description Dictionary. It holds 
the information that describes the world that the simulation 
will be performed on. It is able to standing alone and to be 
loaded into the simulation engine (Charter).  
 

Scenario A scenario consist of only Flight Plans, System Events, 
Student Areas of Control information, and Wind settings. It 
must have a master database to support and complete all 
the information necessary for the simulation engine 
(Charter) to be loaded. The relationship to the master is 
intended to be one master to many scenarios. When a 
scenario is loaded, all of the master only functions are 
disabled automatically. These items will be grayed out when 
every a scenario is loaded. 
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4 File Names (.c2k) 
 
The Create2000 files should all use the file extension of  ".c2k". Version 3 of 
CREATE called OpenCREATE used the extension ".CRT". These files cannot be 
loaded into Create2000. These files can however be updated using the 
Construct2000 program which can convert an OpenCREATE database into a 
Create2000 format. 
 

Masters All master filenames are the name of the master followed 
by "-Master.c2k". Example: A master named "test" would 
have the file name of Test-Master.c2k. 

 
Scenarios All scenario file names are the name of the master followed  

by a dash and then the name of the scenario database with 
".c2k" at the end. Example: A scenario named "exercise1" 
and references the "Test" master database would be named 
Test-Exercise1.c2k. 
 

This naming convention must be followed. A scenario cannot be loaded that 
references a master file that does not exist. 
 

5 Location 
 
Any time a location field is available for input, the user can input any of the valid 
formats in that field as shown in the following picture. 
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6 Menus 
 
The menu buttons allow functions to be used. When a function is not permitted 
it is grayed out and does not work. 
 

6.1 Main Menu & Toolbars 
 
The main menu & toolbars are displayed across the top of the program window. 
 

 
 
The Main menu has four sub-menu buttons; File, Edit, View & Help. There are 
two toolbars, Toolbar & Workbar. These are described in the following 
paragraphs. 
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6.1.1 File 

 
 
The File menu is used mainly in support of file operations. Described below is a 
brief description of each buttons functions. 
 
New This button creates an empty Scenario database only. User is 

required to select a Master file and input the name for the New 
Scenario. 

Open… This button allows an existing Master or Scenario Database to 
be loaded. 

Close  This closes the database that is loaded. If changes have been 
made the user will be asked if they want to save the changes. 

Save This saves the loaded database using the original name of the 
database. 

Save As… This saves the loaded database using a new name. 
Configure This allows the user to configure Create2000. Important data 

directory locations are set here. 
Print Screen This function is used to print the map to the printer. 
Print Setup… This allows the user to determine which printer is to be used 

and the configuration of that printer. 
Exit This exits the program. 
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6.1.2 Edit 
 

 
 
The main menu is displayed across the top of the program window. The Edit 
submenu item allows access to the different States described later, the Set 
submenu and many different functions used in configuring and changing the 
environment. Each item will be discussed in detail in later sections.  
 
Note: All the available functions under the Edit submenu are duplicated on the 
Context menu or Popup menu. This menu is available by clicking the right mouse 
button on the mapping area.   
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6.1.2.1 State 
 
The State menu is used to display the next level of submenu. 
 

 
 
The State submenu is used to select which configuration the software is in and 
the rules that are in effect. This is the most sophisticated cascading menu used 
by the software. Each State will be discussed in future paragraphs.
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6.1.2.1.1 Pointer 
 
The Pointer State is the default position. When in the Pointer State the user has 
the ability to click on a map item on the screen and see the label displayed for 
that item. 
 
Before 

 
 
After clicking on a map item with the left mouse button. 
 

 
 
This function is very helpful when trying to determine the name of a map item 
and you do not want to turn "On" all the map labels. Turning on the labels 
sometimes leads to information overload for the user with to much data being 
displayed at one thing. 
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6.1.2.1.2 Aircraft Characteristics 
 
This State allows the user to work with the aircraft characteristics in the 
database. Each aircraft characteristics is referred to as a Category. This is a 
Master only function, so a Scenario is not able to modify/add information to this 
area. 
 

 
 
There is no limit on the number of Categories that a database can have.  
 
Active Error Checking is performed on the Categories and the results are 
displayed in the status window. 
 
If a Category is found to have an error, simply double click on the error message 
and that flight plan will be loaded and the cursor moved to the field in question. 
Data areas that display the data in a list box do not perform this function.  
 
When no Category is selected, the Errors are displayed for all Categories. When 
a Category is selected, only Errors for that Category are displayed.  
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6.1.2.1.3 Beacon Classes 
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6.1.2.1.4 Display Configuration 
 
The Display Configuration area is used to configure the different medium fidelity 
display supported by SIGNAL. This allows a unique configuration to exist for 
each scenario has needed to support training. 
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6.1.2.1.4.1 DEDEM 
 
The DEDEM Display Configuration allows the setting of the following display 
settings as well as the selected codes and adapted codes for the scenario. 
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6.1.2.1.4.2 DSREM 
 
The DSREM Display Configuration allows the setting of the DSREM medium 
fidelity display setting. These setting can be scenario unique. 
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6.1.2.1.5 Flight Plans 
 
Flight plans can be input into Master or Scenario databases. Normally the flight 
plans will reside in a Scenario. Flight Plan contain the data concerning all the 
aircraft that will be in the Scenario and the events that are associated with these 
aircraft.  
 

6.1.2.1.5.1 Flight Plan List 
 
This window is used to display a list of all the existing flight plans. 
 

 
 
Active Error Checking is performed on the Flight Plan and the results are 
displayed in the status window of the List of Filed Flight Plans. If a flight Plan is 
found to have an error, simply double click on the error message and that flight 
plan will be loaded and the cursor moved to the field in question. 
 
The Auto-Handoff information is used to set a Handoff event packet on a flight. 
This calculation can be done based on Distance or Time. If Distance is selected 
then the edit box is implied to be in terms of miles. If Time is selected then the 
edit box is implied to be in terms of minutes. This is where the default values for 
this data is set. This data is part of the database and stored whenever a 
database is saved.  
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 List of Filed Flight Plans functions 
 
New This function generates a new Flight Plan. 
Update The user must first select a Flight Plan from the list and then 

pressing this button allows access to the Flight Plans data. 
Delete The user must first select a Flight Plan from the list and then 

pressing this button allows the user to delete the Flight Plan. The 
Confirm Delete Box is displayed and "Yes" must be selected before 
the delete will happen. 

Duplicate The user must fist select a Flight Plan from the list and then 
pressing this button duplicates that flight plan and creates a 
second one. 

Include This allows Flight Plans from other Create2000 files to be Included 
into the current file. 

DYSIM This allows DYSIM Flight Plans to be Auto-Loaded into the current 
file. 

Strip 
Processing 

This allows access to the Strip Processor. 

Exit This deletes the Flight Plan List window, exits the FFP State and 
return to the Pointer State. 
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6.1.2.1.5.2 New Flight Plans 
 
New Flight Plans can be input by pressing the "NEW" button and using this 
window. The format for the input is based on the FAA's FDEP format. This 
format is displayed under the input window.  
 

 
 
Data items in the Route are separated as follows: 
 

 (..) 2 Periods separate like items. 
 (.) 1 Period separates unlike items. 
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6.1.2.1.5.3 Flight Plan Update 
 
Flight Plans can be modified by selecting a Flight Plan from the FFP List and 
pressing the "Update" button.  
 
 

6.1.2.1.5.4 Flight Plan Delete 
 
Flight Plans can be deleted by selecting a Flight Plan from the FFP List and 
pressing the "Delete" button.  
 
 

6.1.2.1.5.5 Flight Plan Duplicate 
 
Flight Plans can be duplicated by selecting a Flight Plan from the FFP List and 
pressing the "Duplicate" button.  
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6.1.2.1.5.6 Flight Plan Includes 
 
This window lets the user browse to another Create2000 file and display the 
Flight Plan in that file. 
 

 
 
These Flight Plans can be included into the current file by selecting the desired 
Flight Plans and then pressing the "Include" button. The selected Flight Plans will 
be copied into the Filed Flight Plan area of the current file. 
 
 
Browse This button brings up the File Select Dialog and allows the user 

to select a Create2000 file. 
Include This button adds all the selected Flight Plans from the list into 

the current file. 
Select All This button selects all the Flight Plans. 
Deselect All This button deselects all the Flight Plans. 
Exit This button exits the window back to the FFP list. 
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6.1.2.1.5.7 DYSIM Flight Plans 
 
This window lets the user browse to a DYSIM file and display the Flight Plan in 
that file. 
 

 
 
These Flight Plans can be included into the current file by selecting the desired 
Flight Plans and then pressing the "Include" button. The selected Flight Plans will 
be copied into the Filed Flight Plan area of the current file. 
 
 
Browse This button brings up the File Select Dialog and allows the user 

to select a DYSIM file. 
Include This button adds all the selected Flight Plans from the list into 

the current file. 
Select All This button selects all the Flight Plans. 
Deselect All This button deselects all the Flight Plans. 
Exit This button exits the window back to the FFP list. 
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6.1.2.1.5.8 Flight Plan Strip Processing 
 
Flight Plans Strips can be generated and printed by pressing the "Strip 
Processor" button.  
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6.1.2.1.5.9 Flight Plan Window 
 
This window is used to display the data for a Filed Flight Plan. The functions on 
this window are grouped into 4 groups; Flight Data, Flight Fix Slots, Conditional 
Events & Error Processing. 
 

 
 
Flight Data the FDEP data items that make up the flight plan. The data fields 
are clearly explained as to what the data is. 
 
Flight Fix Slots are the points in space that this aircraft is to fly to. Delete 
allows a fix slot to be deleted, Edit allows information on an existing flight slot to 
be modified, Calculate Route causes the Rough Route Calculator to be brought 
up and Tailor allows access to the graphical presentation of the flight data. 
 
Conditional Event are time based either from the start of a exercise or start of 
the flight. The events as found in the Pilot Users Manual can be input here and 
in that same format. 
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Error processing is active on this window. The bottom list window displays the 
current status of the flight plan. If an error exist, then it will be displayed in this 
window. By double clicking the left mouse button on an error in this list, the 
focus is moved to the field that is in error for modification. Errors should be 
resolved, while warnings indicate unusually conditions like a duplicate beacon 
code or AID that may be intentional.  
 

6.1.2.1.5.10 Flight Plan Events 
 

 
 
Events can either be entered as a Condition Event as seem on the Flight Plan 
Window or as a Positional Event that is associated with a Flight Fix Slot. In both 
cases, the events that are available are the same as found in the SIGNAL Pilot 
Users Manual under Pilot Commands.  
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6.1.2.1.5.11 Flight Slot 
 
Flight Slots are the points in space that this aircraft is to fly to. Event associated 
with this Flight Slot's location can be input and managed here. 
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6.1.2.1.5.12 Rough Route 
 
Initialization of this window copies the flight plan Route into the Route of Flight 
edit window.  
  
Note: When inputting a Route, if using a format that has a period(.) as part of 
the format, then the parameter must be enclosed in square brackets []. 
 

 
 
Pressing the Calculate button will cause a new array of fix slots to be generated 
based on the Filed Flight Plans data. Abort returns back to the FFP window. 
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6.1.2.1.5.13 Rough Route Calculation 
 

 
 
Once the Calculation has been performed, Apply causes the fix slot data to be 
updated. Abort returns back to the FFP window. 
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6.1.2.1.5.14 Rough Route Errors 
 
In the event that the Flight Plan Route references a data item, that can not be 
resolved, this dialog window will be displayed to let the user know that a 
problem has occurred. The invalid data items are dropped from the new fix slot 
data so that the remaining data would be valid. 
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6.1.2.1.6 Map Credit 
 
 
 
The Map Credits window is used to 
mark the display and printed maps 
with a credits paragraph. Both a 
Scenario and Master can access and 
change this window's information, 
but only the Master can save this 
information. All Scenario changes 
are only temporary and intended to 
allow unique printing of maps. 
 
 
 
 
 
 
 

 
 
Position The credits can be position vertically at the top or bottom and 

horizontally left, center and right. 
Print Size This is in terms of Pitch. 14 would be a 14 Pitch font. 
Display This enables and disables the display of the Map Credits 

information. 
Information This is where any message can be input as a map credits 

paragraph. This area has 4 lines of input. 
Exit This exits the Map Credit area. 
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6.1.2.1.7 Mapping 

 
This is a Master only function. 
 

 
 
This State allows the user to get to a lower sub menu on the Mapping items.  
Arrows, Arcs & Lines require two mouse clicks to determine placement, while all 
the rest require only one. 
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6.1.2.1.7.1 Lines 
 
Lines are used to build most airways and boundaries. They can also be used to 
manually build symbols & shapes not found in Create2000 symbol set. 
 

 
 
 
 
Name This is where the name of the line is input. 

 
Type The Types are Solid Line, Short Dash Line & Long Dash Line. 

 
Logical Map This assigns which logical map the lie is associated with. The 

range is 1-10 and All. 
Start Location This is the first latitude/longitude location of this line. 
End Location This is the second latitude/longitude location of this line. 
Fix Gap  This allows a gap to be shown around a intersection or 

symbol. This field is in terms of how many miles the gap 
should be. 

Set Color Reference the Set Color dialog information in the Other 
Windows area of this document. 

Line Width This allows each line to be set to a unique line width. Default 
is 1. 
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6.1.2.1.7.2 Map Symbols 
 
The Map Symbols are all viewable on the Pilot and Controller displays of SIGNAL.  
 

 
 
Name This is where the name of the Map Symbol is input. 

 
Type The Types are Major Airport, Satellite Airport, VORTAC, 

TACAN, Parrot, Obstruction and Intersection. 
 

Logical Map This assigns which logical map the line is associated with. 
The range is 1-10 and All. 

Location This is the latitude/longitude location of this Map Symbol. 
Set Color Reference the Set Color dialog information in the Other 

Windows area of this document. 
Line Width This allows each Map Symbol to be set to a unique line 

width. 
 
Note: Chart Symbols & Map Symbols are different. Chart Symbols are used 
generally for maps that are to be printed, they are not viewable on either the 
Pilot displays or the controller displays. 
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6.1.2.1.7.3 Arcs 
 
The Arcs are used to build any arc from a complete 360 circle to a small pie arc. 
Arcs are excellent for approach plates.  
 

 
 
Name This is where the name of the line is input. 

 
Type The Types are Solid Arc, Short Dash Arc & Long Dash Arc. 

 
Logical Map This assigns which logical map the arc is associated with. The 

range is 1-10 and All. 
Location This is the latitude/longitude center location of this Arc. 
Distance This is the Radius of the Arc in miles. 
End Location This is the second latitude/longitude location of this line. 
Set Color Reference the Set Color dialog information in the Other 

Windows area of this document. 
Start Angle Starting angle of the Arc. 
End Angle Ending angle of the Arc. 
Line Width This allows each Arc to be set to a unique line width. 
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6.1.2.1.7.4 Arrows 
 
The Arrows are intended for maps that are to be printed. The arrows do not 
show up on the Pilot or Controller displays. 
 

 
 
 
Name This is where the name of the Arrow is input. 

 
Type The Types are ILS Arrow, SDF Arrow & LF/MF Arrow. 

 
Logical Map This assigns which logical map the Arrow is associated with. 

The range is 1-10 and All. 
Start Location This is the first latitude/longitude location of this Arrow. 
End Location This is the second latitude/longitude location of this Arrow. 
Set Color Reference the Set Color dialog information in the Other 

Windows area of this document. 
Line Width This allows each Arrow to be set to a unique line width. 
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6.1.2.1.7.5 Chart Symbols 
 
The Chart Symbols are additional symbols that are intended for use when 
building maps for printed only. The Chart Symbols do not show up on Pilot or 
controlled displays. 
 

 
 
 
Name This is where the name of the Chart Symbol is input. 

 
Type The Types are NDB DME, VOR DME, VOR, VORTAC2, & 

TACAN2. 
Logical Map This assigns which logical map the Chart Symbol is 

associated with. The range is 1-10 and All. 
Location This is the latitude/longitude location of this Chart Symbol. 
Set Color Reference the Set Color dialog information in the Other 

Windows area of this document. 
Line Width This allows each Chart Symbol to be set to a unique line 

width. 
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6.1.2.1.7.6 Flags 
 
Flags are generally used only for "Place Holders". They are not viewable by any 
other programs except Create2000. 
 

 
 
Name This is where the name of the flag is input. 

 
Type The Types are Flag1, Flag2, & Flag3. 
Logical Map This assigns which logical map the flag is associated with. 

The range is 1-10 and All. 
Location This is the latitude/longitude location of this flag. 
Set Color Reference the Set Color dialog information in the Other 

Windows area of this document. 
Line Width This allows each Flag to be set to a unique line width. 
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6.1.2.1.7.7 Labels 
 
A Label is used to place text on the map in a particular way in relation to size, 
angle, color, and line width. 
 

 
 
 
 
Name This is where the name of the label is input. 

 
Type The Type is Label. 
Logical Map This assigns which logical map the label is associated with. 

The range is 1-10 and All. 
Location This is the latitude/longitude location of this label. 
Set Color Reference the Set Color dialog information in the Other 

Windows area of this document. 
Rotation Angle Used to rotate the Label to a desired angle. This field uses a 

mathematical angle, where 0 is right and flat and the rotation 
is counter-clock wise. 

Scale Used to scale the Label to the desired size. 
Line Width This allows each Label to be set to a unique line width. 
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6.1.2.1.7.8 3D Objects 
 
The 3D Objects option is an area of new development and are not usable yet. 
These shapes do not show up on the Pilot or Controller displays. 
 

 
 
Name This is where the name of the 3D Object is input. 

 
Type The Types are AT Tower, Antenna, Bridge, Hanger, 

Mountain, Radar Site, Terminal, & Water Tower. 
 

Logical Map This assigns which logical map the 3D Object is associated 
with. The range is 1-10 and All. 

Location This is the latitude/longitude location of this 3D Object. 
Set Color Reference the Set Color dialog information in the Other 

Windows area of this document. 
Rotation Angle Used to rotate the object. 
Scale Used to scale the object 
Line Width This allows each 3D Object to be set to a unique line width. 
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6.1.2.1.8 MSAW 
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6.1.2.1.8.1 Posts 
 

 
 

6.1.2.1.8.2 Subareas 
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6.1.2.1.8.3 Areas 
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6.1.2.1.9 Parameters 

 

 
 
Both Scenarios and Master databases have a Parameters file. This data area is 
used to determine a starting configuration when a database is loaded. Also 
anytime the "Restore to Original" button is pressed, this information is used to 
determine that configuration. 
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Type This is where the type of database is set.  
Range This is in terms of nautical miles. 
Magnetic 
Variation 

The Magnetic Variation field is used to determine where True 
North is from Magnetic North. The Controller displays handle 
this information differently. Some displayed rotate to show 
Magnetic North straight up while other displays add the 
Magnetic Variation to an Aircraft's heading. 

Exercise Clock 
Start 

This field is used to offset the displayed starting time. Format 
is HHMM where HH(Hours) is 0-23 and MM(Minutes) is 0-59. 

Point of 
Tangency 

The Point of Tangency is the geographic Latitude/Longitude 
center of the database. This is also known as the "Center of 
the Display". 
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6.1.2.1.10  Radar 
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6.1.2.1.10.1 Radar Sort Box (RSB) 
 
This is a Master only function. 
 

 
 
This Window allows the user to changes the WeatherStation and selected Radars 
in a RSB grid. To activate this window change the state to RSB and click on a 
RSB grid box. 
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6.1.2.1.10.2 RSB Configure 
 
This is a Master only function. 
 

 
 
This Window allows the user to configure the MSAW grid for this database. 
 
Range This is where the range for the RSB grid is input. This is in 

terms of nautical miles. 
Grid Size This is whether the grid size of the RSB grid is input This is in 

terms of nautical miles. 
Configure This activates the configuration software and generates a 

new RSB grid. Note: this will destroy any already existing 
RSB grid and its configuration. 

Exit This Exits the RSB Configure part of the software. 
 
All RSB grids are square in shape. To calculate the size of the RSB grid, ((Range 
/ Grid Size) + 1 ) * 2  is equal to how many rows & columns  in grid. 
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6.1.2.1.10.3 Radar Sites 
 
This is a Master only function. 
 

 
 
Radar Sites are used to determine how to draw Analog Weather patterns on the 
Controller displays. Analog Weather is displayed a series of Radial Line center on 
a Radar Site and covering the weather area. This generates a kind of pie slice 
look. Also a Radar Site cannot generate a weather pattern directly above it, so 
usually the Radar Site is located off the displayed map. Normally, a database 
only has one Radar Site. 
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6.1.2.1.11  Regions 
 

 
 
This is a Master only function.  When pressed the below list window is displayed. 
This window will contain a list of all the existing Regions. The user can now 
perform the following function: New, Update, Delete or Exit. 
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New This function generates a new Region with no data points. 
Update The user must first select a Region from the list and then pressing 

this button allows access to the Regions data. 
Delete The user must first select a Region from the list and then pressing 

this button allows the user to delete the Region. The Confirm 
Delete Box is displayed and "Yes" must be selected before the 
delete will happen. 

Exit This deletes the Region list window, exits the Regions State and 
return to the Pointer State. 
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This window is displayed when a Region Add or Update is selected. 
 

 
 
 
Name The user can assign a name here. A name is automatically 

generated. 
Type The user can set the Type of Region this is. 
Altitude The user can set the upper and lower altitude of the Region 

here. 
Tailor  This allows access to the points that make up the polygon that 

defines the Region. To exit this mode press Enter or End on the 
Keyboard. 

Delete Point This allows the user to select a point of the region from the list 
and delete that point. The deletion must be confirmed. 

Exit This Exit this Region window back to the Region List window. 
 

 48



SIGNAL Project, DOT/FAA/AMI-800 
Create2000 V4.0 Reference Manual 
 
3/24/2005 

6.1.2.1.12  Route Processing 

 
This is a Master only function.  
 

 
 
This submenu allow the users to access the areas that allow Add, Modify and 
Delete of the Fixes, Airport/Runways, Approaches, Departures, Route, SIDs and 
STARs as described in the following sections. All these submenu functions are 
Master only. 
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6.1.2.1.12.1 Fixes 
 
This is a Master only function. This is the window that is displayed when adding 
or modifying a fix.  
 

 
 
 
Name This is where the name of the fix is input. 

 
Location This is the latitude/longitude location of this fix. 
Mag Var This is the Magnetic Variation for this fix. The format is 

###C where ### is a number from 0-360 and C is equal 
to E for East or W for West. 

Single Letter ID It the fix is also known by a single letter, it can be input 
here. 

Attributes Allows a fix to be known as a airport, focal point, posting fix 
or holding fix. As many of these as are needed may be set 
at one time. 

Holding 
Information 

This area consist of 3 data items; Radial, Leg and Turn. In 
order to input data, the Holding Fix attribute must be set. 
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6.1.2.1.12.2 Airport/Runways 
 
This is a Master only function. 
 

 
 
The above window allows a new airport to be created or an existing one to be 
modified or deleted. When New or Update is selected the below window allows 
for the airport data to be input or modified.  
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At this point the below data area can be modified. 
 
Name This is where the name of the airport is input. 

 
Associated 
Navaid 

This is a fix that is associated with the airport. En Route like 
to fly to this fix, while Terminal does not. 

Elevation This is elevation of the fix in feet. 
FDEP This is selected if the airport is a FDEP facility. 
 
The ability to Add, Delete and Modify, the runway data is also available at this 
time.  The next level of window displayed is when the Add or Modify button is 
pressed. 
 

 
 
From this window the following can be input. 
 
Name This is where the name of the runway is input. 
Active This is whether the runway is active or not. 
Width This is the width of the runway in feet. 
Start Location This is the first latitude/longitude location of this runway. 
End Location This is the second latitude/longitude location of this runway. 
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At this time the user can choose to go one level deeper into the Visual Approach 
Profile (VAP) area by selecting Add VAP and this window is displayed. 
 

 
 
The user is required to select the Weight Classes that are appropriate.  The 
distances are required for Base to Start of Runway, End of Runway to Crosswind 
and Runway to Downwind. 
 
Finally, once a runway is built the user is asked if they would like to opposite 
runway to be generated automatically. 
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6.1.2.1.12.3 Approaches 
 
This is a Master only function. 
 

 
 
This window allows the user to create a new Approach, Modify an existing 
approach or Delete an existing approach. The existing Approaches are displayed 
in the list and indention is used to indicate relationship. Example: KMIO in the 
window above has 3 approaches, two for runway 18 and one for runway 36. 
Redundant information is not displayed. By selecting, New or Update this next 
window will be displayed. 
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6.1.2.1.12.4 Departures 
 
This is a Master only function. 
 

 
 
This window allows the user to create a new Departure, Modify an existing 
Departure or Delete an existing Departure. The existing Departures are displayed 
in the list. By selecting, New or Update this next window will be displayed. 
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6.1.2.1.12.5 Routes 
 
This is a Master only function. 
 

 
 
This window allows the user to create a new Route, Modify an existing Route or 
Delete an existing Route. The existing Routes are displayed in the list. By 
selecting, New or Update this next window will be displayed. 
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6.1.2.1.12.6 SIDS 
 
This is a Master only function. 
 

 
 
This window allows the user to create a new SID, Modify an existing SID or 
Delete an existing SID. The existing SIDs will be displayed in the list. By 
selecting, New or Update this next window will be displayed. 
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6.1.2.1.12.7 STARs 
 
This is a Master only function. 
 

 
 
This window allows the user to create a new STAR, Modify an existing STAR or 
Delete an existing STAR. The existing STARs are displayed in the list. By 
selecting, New or Update this next window will be displayed. 
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6.1.2.1.13  Sectorization 

 
This is a Master only function. 
 

 
 
This submenu allow the users to access the areas that allow Add, Modify and 
Delete of Nodes, FPAs, Sectors, Transition Lines, MSAW Post, MSAW Subareas, 
MSAW Areas, Radar Sort Box Configuration, RSB & Radar Sites as described in 
the following sections. All these submenu function are Master only. 
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6.1.2.1.13.1 Nodes 
 
This is a Master only function. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Nodes are used to identify a Latitude/Longitude position with a name. When 
building a FPA (Fix Posting Area), you reference Nodes to describe the Modules 
physical shape. 
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6.1.2.1.13.2 Modules 
 
This is a Master only function. 
 

 
 
This window allows the user to create a new Module, Modify an existing Module 
or Delete an existing Module. The existing Modules are displayed in the list. By 
selecting New or Update, this next window will be displayed.  
 
 

 
 
This window is used to configure a Module. A Module is a collection of Nodes. 
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6.1.2.1.13.3 FPAs 
 
This is a Master only function. 
 

 
 
This window allows the user to create a new FPA, Modify an existing FPA or 
Delete an existing FPA. The existing FPAs are displayed in the list. By selecting 
New or Update, this next window will be displayed.  
 

 
 
This window is used to configure a FPA. A FPA is a collection of inclusion and 
exclusion Modules. 
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6.1.2.1.13.4 Sectors 
 
This is a Master only function. 
 

 
 
This window allows the user to create a new Sector, Modify an existing Sector or 
Delete an existing Sector. The existing Sectors are displayed in the list. By 
selecting New or Update, this next window will be displayed.  
 

 
 
This window is used to configure a Sector. A Sector is a collection of FPAs. 
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6.1.2.1.14  Student Areas of Control 

 

 
 
This area allows the users to setup the Students for the Scenario.  
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A Student has an assigned name, center of display and assigned sectors. This 
window allows this type of interaction.  
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6.1.2.1.15  System Events 
 

 
 
System Events are used to control the scenario environment, not aircraft. These 
events are as follows; 
 

 Alpha Numerics (Failure/Recovery) 
 ARTS System Events( Altimeter, ATISC, General Information, Operational 

Level, Environmental Data) 
 Departure Delay( Airport & Time) 
 Facility Interface( Facility ) 
 Radar( Failure/Recovery) 
 Runway(Activate/Deactivate) 
 Scenario Information(Text) 
 System Prompt(Text) 
 Weather Cell(Activate/Deactivate) 
 Weather Station(Altimeter, Report). 

 
Selecting the System Events menu item will display the System Event List 
window. 
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6.1.2.1.15.1 System Event List 
 

 
The Delete Button requires that a System Event be select from the List and 
then the Delete must be confirmed. 
 
The Modify Button allows the modification of the System Event data and 
requires that a System Event be selected from the List first. Double clicking on a 
list item will take that System Event into the Modify mode. 
 
The Add Button will display this window. The Time and Type of event can be 
set at this time. Once an event is added the Type for that event cannot be 
changed. The Time can be changed during modify at anytime.  
 

 
 
The Exit button will exit the System Event Area. 
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6.1.2.1.15.2 Alpha Numeric Event 
 

 
 
This System Event controls the display of Alpha Numeric Data on the Controller 
display. Valid actions are Failure & Recovery. 
 

6.1.2.1.15.3 Arts System Event 
 

 
 
This System Event is used to change ARTS configuration data. The Altimeter, 
ATISC, Operational Level and General Information field in the System Data Area 
can be changed. The Environmental Data display area can be changed also.  
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6.1.2.1.15.4 Departure Delay Event 
 

 
 
This System Event allows an Airport's Departure Delay time to be changed. 
 

6.1.2.1.15.5 Facility Interface Event 
 

 
 
This System Event allows the Interfacing between Facilities to Activated or 
Deactivated. 
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6.1.2.1.15.6 Radar Event 
 

 
 
This System Event allows the Radar to be Failed or Recovered. 
 

6.1.2.1.15.7 Runway Event 
 

 
 
This System Event allows a Runway to be Activated or Deactivated. This only 
effects the List of Valid Approaches available for Pilot Selection. 
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6.1.2.1.15.8 Scenario Information Event 
 

 
 
This System Event allows a story like text to be sent to either the Pilot or 
Controller or Both. This is used to acquaint the student and pilot of important 
information needed in the scenario. 

6.1.2.1.15.9 System Prompt Event 
 

 
 
This System Event is used to Prompt the Pilot of an event that is about to 
happen.  
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6.1.2.1.15.10 Weather Cell Event 
 

 
 
This System Event is used to Activate or Deactivate a Weather Cell. 
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6.1.2.1.16  Tabular Data 
 

'' 
 
This is a Master only area. This area controls the placement of display on the 
Control's display. Only list associated with the Type of database, i.e. Terminal, 
En Route, etc. will be displayed. This software allows these list position indicators 
to be moved to a desired place on the screen.  
 
A lll iiiggghhhttt   gggrrreeeeeennn   XXX is used to indicate the location of the list. These markers can be 
dragged anywhere on the screen as desired. 
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6.1.2.1.17  Weather 

 
This is a Master only function. 
 

 
 
 
These areas are Master only. 
 

1. Visibility Areas 
2. Weather Cells 
3. Weather Stations 
 

The Winds are part of the Scenario data area and can be modified by a Master 
or a Scenario. Normally the Winds would be in the Scenario only. 
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6.1.2.1.17.1 Visibility Areas 
 
This is a Master only function. 
 

 
 
This window allows the user to create a new Visibility Area, Modify an existing 
Visibility Area or Delete an existing Visibility Area. The existing Visibility Areas are 
displayed in the list. By selecting New or Update, this next window will be 
displayed. 
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6.1.2.1.17.2 Weather Cells 
 
This is a Master only function. 
 

 
 
This window allows the user to create a new Weather Cell, Modify an existing 
Weather Cell or Delete an existing Weather Cell. The existing Weather Cells are 
displayed in the list. By selecting New or Update, this next window will be 
displayed. 
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6.1.2.1.17.3 Weather Stations 
 
This is a Master only function. 
 

 
 
Weather Stations are used to add weather information to a scenario. These 
Weather Stations hold the original Time, Altimeter and a Weather Report. 
System Events are used to update these pieces of data as the Scenario is being 
run on the simulator.  
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6.1.2.1.17.4 Winds 
 
This is a Master or Scenario function. 
 

 
 
The above window is used to configure a Wind object. As many Wind object as 
necessary can be created. The Wind objects are activated and deactivated by 
using System Events. 
 
Note: Active Wind objects should not overlap. If this occurs, the resulting 
outcome would not be predictable.  
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6.1.2.1.18  3D Viewer 
 

 
 
This toggles the 3D Display Controls Up/Down. The 3D Display Controls allow 
the user to view the database in a 3D mode. Reference the section concerning 
the Keyboard Functions to determine the associated keys for the Viewer. 
 
Note: The keyboard allows a much smoother operation of the Viewer.  Some 
functions are not assigned to the keyboard and must be performed on the 
Viewer window itself. 
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6.1.2.2 Change Mode 
 

 
 
This toggles the Mode between Add to Modify. The current Mode state is 
displayed in the Toolbar across the top of the Main Window. 
 
 

 
 
 
The Mode is used to determine how each State is to function and to help 
determine Mouse actions. For some States the mode is not used. As a general 
rule, when you are working with the map window, then the Mode is used.  
 
Reference the Keyboard Function section to see how to engage this function via 
the keyboard. 
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6.1.2.3 Change Move 
 

 
 
This toggles the Move between Enabled and Disabled. The current Move state is 
displayed in the Toolbar across the top of the Main Window. 
 

 
 
 
The Move is only active when Mode is in the Modify mode. It is used to 
determine if an existing item for a State can be captured and drug around on the 
screen. As a general rule, when you are working with the map window, then the 
Move is usable.  
 
Reference the Keyboard Function section to see how to engage this function via 
the keyboard. 
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6.1.2.4 The Modify List 
 

 
 
The Modify List can only be displayed when the Mode is set to Modify and one of 
the following States is currently set. 
 

Fixes 
Nodes 
Radar Sites 
Weather Stations 
Winds 
Transition Lines 
Arcs 
Arrows 
Chart Symbols 
Flags 
Labels 
Lines 
Map Symbols 
3D Objects 
 

The List will contain a list of add the items for that State. 
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Example of The Modify List 

 
 
This window function by selecting an item from the list and press the Modify 
button. All the Data Type that can use this window also allows the items to be 
selected by simply clicking the left mouse button on the item. This window was 
intended to allow the selection of items that are presently at a location off the 
screen for modification.  
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6.1.2.5 Display 
 
The Display Window is a Property Sheet that has many Property Pages.  
To access a page, simply click on the desired tab of that page. 
 

 
 

6.1.2.5.1 AMIS 

 

 
 
This Window allows the display of the AMIS data that exist in the database. Only 
real world database will have AMIS data. This data is automatically added by 
pressing the Load/Reload button. 
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6.1.2.5.2 Colors 
 
 

 
 
This Window allows the user to change the Background & Label Color. The 
change is immediate to the display. This information is saved when the database 
is saved and is used when the database is loaded in the future to set the initial 
state of these items.  
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6.1.2.5.3 Fonts 
 

 
 
This Window allows the user to change the Font used on the display. The 
change is immediate to the display. This information is saved when the database 
is saved and is used when the database is loaded in the future to set the initial 
state of these items.  
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6.1.2.5.4 Mapping 
 

 
 
This Window allows the user to configure the Maps that are to be displayed and 
how they are to be displayed. Most items have two check boxes, the right box 
enables the display of the item, the left box turn the label for the item. The label 
is not displayed unless the item is also being displayed. 
 
Another function on this page is the Map Selection which controls of which maps 
are being displayed.  Each Map item when created is assigned to a particular 
map (1-10) or to the "All" maps.  
 
Note: Mapping items that are assigned to "All" maps will only be displayed, if at 
least one of the 1-10 maps is displayed, otherwise they are not displayed. 
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6.1.2.5.5 Methods 

 
This Window allows the user to change the default Methods used by Create2000.  
 

 
 
 
Symbols Choices are Proportional or Fixed. This is used to determine 

when scaling a map, whether the symbol scale with the map 
or stay the same size. 

Display Choices are Jump or Smooth. This function is no longer a 
needed function. This function can about when processors 
could not draw very fast and this was used to let the user is 
something happening while waiting for the screen to finish 
updating.  

Standard Choices are U.S. System or Metric. This changes the 
displayed information of a FRD from miles to kilometers. 
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6.1.2.5.6 MSAW 
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6.1.2.5.7 Radar 

 
This Window controls the display of the Radar associated items. 
 

 
 
Radar Sites The right check box allows the Radar Sites to be displayed 

on the map. The left box allows the Radar Site's names to 
be displayed. The Names are not displayed if the Radar 
Sites are not enabled. 

Coverage Area  This will draw a circle showing the different Radar Sites 
coverage areas on the map. 

Display as Solid If the Coverage Areas are being displayed, this changes 
the displayed of these areas from being a circle to a solid 
circle. Warning: Radar Sites may be covered up using this. 

Radar Sort Box The right check box allows the Radar Sort Box to be 
displayed on the map. The left box allows the Radar Sort's 
information to be displayed. The information is not 
displayed if the Radar Sort Box is not enabled. 
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6.1.2.5.8 Readouts 
 

 
 
The Readouts are located at the bottom of the map window. These windows are 
intended to displayed pieces of information of interest for the user. If a Readout 
window is not selected, then the remaining windows are consolidated to the Left 
of the Map window. Also, if a large Font Size is set, the Readout windows may 
grow to require multiple lines for display.   
 
Facility Sector Selecting this information for display will show a 

continuous readout of the Facility/ Sectors at the 
present mouse location and the altitude strata 
associated with them. 

Map Center This will display the current Map Center. Initially, this is 
the same as the Parameters Data Point of Tangency. 
Once the map is offset this now holds this location.  

Current Lat/Long 
Position 

Selecting this information for display will show a 
continuous readout of the present mouse location in 
terms of Latitude/ Longitude. 

Current XY 
Position 

Selecting this information for display will show a 
continuous readout of the present mouse location in 
terms of XY miles. 
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FRD Center This will display the current FRD Center. Initially, this is 

the same as the Parameters Data Point of Tangency. 
Once a new FRD Center is set, this now holds this 
location. 

FRD Information Selecting this information for display will show a 
continuous FRD readout of the present mouse location 
in terms of the FRD center. 

Current Range This will display the current Range. Initially, this is the 
same as the Parameters Data Range. Once a new 
Range is set, this now holds this Range. 

Current Magnetic 
Variation 

This will display the current Magnetic Variation, which 
is the Parameters Data Magnetic Variation.  If this data 
is changed this window will reflect the change. 

Transparent 
Windows 

If this is selected the readout window will be displayed 
as transparent window. This allows any information 
under the Readout window to be shown through the 
Readout window. 

Font Size This allows the Font Size of the Readout windows to be 
set. 
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6.1.2.5.9 Regions 
 

 
 
This Window allows the user to configure the Regions that are to be displayed 
and how they are to be displayed. There are two check boxes, the right box 
enables the display of the item, the left box turn the label for the item. The label 
is not displayed unless the item is also being displayed. 
 
Regions must be selected in the list for display. As many regions as desired, may 
be selected. Selected Regions are displayed with a dark background in the list.  
 
To Select or De-Select a list item, simply click on the item in the list. This 
function is a toggle. 
 
Finally, the Override List checkbox if selected will display all the Regions. 
 
All changes to page are immediately shown on the map window. 
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6.1.2.5.10  Route Processing 
 

 
 
This Window allows the user to configure the Route Processing Items that are to 
be displayed and how they are to be displayed. There are two check boxes, the 
right box enables the display of this type of item, the left box turn the label for 
the item. The label is not displayed unless the item is also being displayed. 
 
As Fixes & Airports is Selected or De-Selected, the map window is update to 
shown the Selected data. 
 
As for Fix Slots, this information is only shown, once a Route/Airway, SID, STAR, 
Approach or Departure is displayed. 
 
As Route/Airways, SIDs, STARs, Approaches or Departures is Selected or De-
Selected, the list window will be reconfigured to hold all the Selected type of 
data items. Route Processing item must be selected in the list for display. As 
many Route Processing items as desired, may be selected. Selected Route 
Processing items are displayed with a dark background in the list.  
 
To Select or De-Select a list item, simply click on the item in the list. This 
function is a toggle. 
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Finally, the Override List checkbox if selected will display all of the Route 
Processing item displayed in the list. All changes to page are immediately shown 
on the map window. 
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6.1.2.5.11  Sectorization 
 

 
 
This Window allows the user to configure the Sectorization Items that are to be 
displayed and how they are to be displayed. There are two check boxes, the 
right box enables the display of this type of item, the left box turn the label for 
the item. The label is not displayed unless the item is also being displayed. 
 
Nodes Displays all the Nodes in the database.  
FPA’s This allows FPAs to be displayed. The list selection must also 

be performed in order to see a FPA displayed. 
MSAW This displayed the current MSAW grid. If labels are also 

selected then the altitude configuration for the gird is also 
displayed.  

A Line, B Line, 
D Line, S Line, 
T Line 

This controls the display of these types of Transition Lines. 

Altitude Block The edit box allow a altitude range to input and then by 
selecting Altitude Block the altitude range is used to 
determine which FPA are displayed. 

Override List If selected, this displays all the FPAs in the list. 
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Items selected in the Sector list, auto-select the corresponding FPAs that make 
up that Sector. FPAs in the FPA list can be Selected or De-Selected as needed. 
To Select or De-Select a list item, simply click on the item in the list. This 
function is a toggle. All changes to page are immediately shown on the map 
window. 
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6.1.2.5.12  Special  
 

 
 
This window holds a collection displays item. 
Scope Ring This will display a Ring that depicts the location of the 

edge of the display for circular displays.  
Map of United 
States 

This will display a map of the United States. 

Map of ARTCC’s This will display a map of the boundary of the different 
ARTCC’s in the United States. 

Tabular Data This will display the Tabular Data items at their 
locations for the database. 

GCL Picture This allows a GCL picture to be displayed as a 
background. This is used when building a T2D database 
to confirm the location of the various items on the map. 

Range Mark This allows Range Marks to be displayed at the selected 
interval designated in the Pop-down window. 

Grid XY This allows a XY Grid to be displayed at the selected 
interval designated in the Pop-down window. 

Gird Lat/Long This allows a Latitude/ Longitude Grid to be displayed at 
the selected interval designated in the Pop-down 
window. 
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All changes to page are immediately shown on the map window. 

 99



SIGNAL Project, DOT/FAA/AMI-800 
Create2000 V4.0 Reference Manual 
 
3/24/2005 

6.1.2.5.13  Terrain 
 

 
 
3D Terrain data can be selected for display. At this time only the GTOP030 data 
is available, but this data does cover the entire world. Caution: displaying to 
much terrain data can seriously effect the performance of the machine 
and software.  
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6.1.2.5.14 Weather 
 

 
 
Weather Cells and Visibility Areas – Both have a common design and the 
interface is the same. Each area has two check boxes. The right one allows the 
display of the item the left one controls the display of the label for the item. The 
label will not be displayed if the right button is not selected. Weather Cells has 
an additional check box for allowing the display of the Heavy Weather Indicators.  
 
The two areas each have a list to select items with. To Select or De-Select an 
item, simply click on the item. This is a toggle. 
 
Both areas also have a Override List checkbox. This allows all items in the list to 
be displayed without being selected.  
 
Weather Station and Winds - They both follow the above rules for when a 
item has two check boxes. The right one allows the display of the item the left 
one controls the display of the label for the item. The label will not be displayed 
if the right button is not selected. 
 
 
All changes to page are immediately shown on the map window. 
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6.1.2.5.15  3D Objects 
 

 
 
All items follow the rules for when a item has two check boxes. The right one 
allows the display of the item the left one controls the display of the label for the 
item. The label will not be displayed if the right button is not selected. 
 
All changes to page are immediately shown on the map window. 
 
Note: The 3D Objects data is not intended for use yet. This is just a new 
development area that could potentially evolve into a 3D modeler for the future 
3D Tower project.    
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6.1.2.6 Reports 
 
The Reports menu is used to display the report dialog. 
 

 
 
This menu allows the user to generate reports for viewing or printing. The Print 
Setup page allows the configuration of the Printer. 
 
Select all the reports that are desired and then select the method for viewing, 
Printed or Displayed on the screen. 
 
The Select All button Selects all reports and the Clear button De-Selects all the 
reports. 
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6.1.2.7 Restore To Original 
 

 
 
The "Restore To Original" menu resets the map center and range to original 
setting. This information is the data found in the Parameters area. 
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6.1.2.8 Move To… 
 

 
 
The ”Move To” menu displays this window, which allows the user to select a fix 
or a Map symbols name from the list and then move the center of the map 
display to that location. Also, the Location field allows additional inputs as 
identified in paragraph Location as valid input. 
 
 

 

 105



SIGNAL Project, DOT/FAA/AMI-800 
Create2000 V4.0 Reference Manual 
 
3/24/2005 

6.1.2.9 Set 
 

 
 
The Set menu allows the user to set the following items, Current Center, Current 
Range, Current MagVar (Magnetic Variation) and Current FRD Reference point. 
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6.1.2.9.1 Set Current Center 

 

 
 
The Set Current Center works the same way as discussed in Center & Offset 
Center. 
 

 107



SIGNAL Project, DOT/FAA/AMI-800 
Create2000 V4.0 Reference Manual 
 
3/24/2005 

6.1.2.9.2 Set Current Range 
 

 
 
 
The Set Range menu allows the user to set the range for display. This input is in 
terms of nautical miles. 
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6.1.2.9.3 Set Current Mag Var (Magnetic Variation)  
 

 
 
 
The Set menu allows the user to set the following items. The format for input is 
###C where ### is a number 0-360 and C is E for East or W for West. 
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6.1.2.9.4 Set FRD Reference 

 

 
 
This allows the user to select a new FRD center location via clicking the mouse 
on the map in the location you wish to be the new FRD center. The FRD readout  
is then updated based on the new FRD center location. 
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6.1.3 View 
 
 

 
 
The View menu is used to select or deselect for display the Toolbar and the 
Workbar. Reference Toolbar and Workbar for additional information. 
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6.1.4 Help 
 

 
 
The Help menu allows the display of the About box. This is the standard 
Microsoft way of allowing the author to convey development information about 
the program to the user. 
 

6.1.4.1 About Box 
 

 
 
The About Box is used to convey information about this program such as the 
origin, author, subject matter expert, support and additional information 
locations. This box has no other function. 
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6.1.5 Toolbar  
 

 
 
This toolbar allow three basic function of Zoom, Center and Font Size change.  
This toolbar can be taken down/up by selecting/deselecting the Toolbar button 
on the View menu of the Main menu.   
 

6.1.5.1 Zoom In & Out   
 

 
 
The icon that has a plus (+) is used to zoom in and the icon that has a minus (-) 
is used to zoom out.   
 

6.1.5.2 Center & Offset Center 
 

 
 
The icon with the boxes centered, when pressed, causes to map to be centered. 
When the icon with the boxes not centered is pressed the user is allowed to 
select a new center via clicking the mouse on the map in the location you wish 
to be the new center. The map is then displayed using this new center. 
 

6.1.5.3 Font Size Increase & Decrease 
 

 
 
The icon with the smaller letters allows the user to decrease the font size of the 
labels on the mapping window. The icon with the larger letter increases the font 
size of the labels on the mapping window. 
 
The Readouts at the bottom of the mapping window are not affected by this 
process. To change the Readout’s font size, reference the paragraph on 
Configuration dealing with Readouts. 
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6.1.6 Workbar  
 

 
 
This toolbar allow the user to determine State, Mode (Add/Modify) and whether 
Move is enabled or disabled.  This toolbar can be taken down/up by Selecting or 
De-Selecting the Workbar button on the View menu of the Main menu.   
 

6.2 Context Menu 

 
 
The context menu can be displayed by clicking the right mouse button on the 
program window. This menu's functions and submenu functions are the same as 
the Main menu's Edit menu. For addition information reference the paragraph on 
the Edit menu. 
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7 Keyboard Functions 
 
These buttons have been programmed to perform specific function as listed 
below. 
 
<Key                                   Function                                             >                                
 
F1 This function button brings up the Select State window. 

 
F2 This function button toggles the Mode between Add & Modify. 

 
F3 This function button toggles the Move between Enabled & 

Disabled. 
 

F4 This function button toggles the 3D Viewer up & down. 
 

F5 This function button brings up the Set Range window.  
 

F6 This function button toggles the display of the Display window. 
 

F7 This function button toggles the display of the Configure 
window. 
 

F8 This function button toggles the display of the Report window. 
 

F9 This function button brings up the Modify List window. 
 

F10 This function button toggles the display of the Global Scaler 
Window. 
 

F11 This function button toggles the display of the Track Animator. 
Enter, End These buttons allow the user to exit the tailor mode. 

 
+ This button Zooms in. 

 
- This button Zooms out. 

 
Up Arrow Active only when the 3D Viewer is active. This causes a 

positive rotation on the X axles. 
 

(Continued) 
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<Key                                   Function                                             >                                
 
Down Arrow Active only when the 3D Viewer is active. This causes a 

negative rotation on the X axles.  
 

Right Arrow When the 3D Viewer is active, pressing this button causes a 
positive rotation  on the Y axles. When the Global Scaler is 
active the size of the items is increased. 
 

Left Arrow When the 3D Viewer is active, this causes a negative rotation 
on the Y axles. When the Global Scaler is active the size of the 
items is decreased. 
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8 Mouse Functions 
 
The Create2000 has been written to use the standard 2-button mouse. Many 
function have been programmed to take advantage of the mouse. Below is a 
listing of these functions. 
 
Left Button   The Left mouse button is used to input and modify almost 
all the Create2000 data items. It is used to set the Latitude/Longitude location 
for items. Below is some of the other function the Left mouse performs. 
 

Set Center & Range The mouse can be used to set a new center 
and range. This is done by holding down the Ctrl button on the keyboard 
then clicking the left mouse button down on the location you want to be 
the new center. While holding down the mouse button move away from 
the center to where the desired range is within the displayed white circle, 
then release the left mouse button. The display should then be redrawn 
using the new center and the calculated new range based on the radius of 
the circle.  
 
Set Center   The left mouse button is used to complete the 
"Edit Set" function "Set Center". Simply click on the location of the map 
that you desire to be the new center. The map should be redrawn using 
the new center selected. 
 
Pointer   The left mouse button is used to select objects 
when in the Pointer State. This selection causes temporary labels for 
these mapping items to be displayed. 
 
Set FRD   The left mouse button is used to complete the 
"Edit Set" function "Set FRD". Simply click on the location of the map that 
you desire to be the new FRD center. The readout displayed at the 
bottom of the map should not use the new FRD location to determine the 
displayed FRD information. 
 

 
Right Button This button is used to bring up the Context Menu or Popup 
Menu. This menu allows selection of all the functions found on the Main menu 
Edit submenu. 
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9 Other Windows 
 
This area covers all the miscellaneous windows and their functions. These 
windows are generally used in many places as needed. 
 

9.1 Confirm Delete Window 
 

 
 
Anytime an item is being deleted, this window is used to confirm that delete 
action. If the "NO" button is pressed the delete is halted.  
 

9.2 Invalid Input Window 
 
 

 
 
 
Anytime a user's input cannot be determined, this window is displayed. 

9.3 Nothing Selected Window 
 

 
 
This window is displayed anytime a user is required to select an item from a list 
before performing the desired action and has not done so. 
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9.4 Not Unique Window 
 

 
 
 
This window is displayed if the data item name is not unique and it is required to 
be so. 
 

9.5 Save Database Window 
 

 
 
 
This window is displayed if the user tries to exit the program and the software 
has determined that changes have been made to a database and that database 
has not been saved. 
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9.6 Progress Write 
 

  
 
This indicator is displayed when a database is being saved. 
 

9.7 Progress Read 
 

 
 
This indicator is displayed when loading a Master or Scenario. The top progress 
bar indicates the loading of the Master and the bottom progress bar indicates the 
loading of the Scenario.  
 
Note: Even when loading just a Master the data areas for a Scenario are loaded 
with the data from the Master because a Master can store both Master and 
Scenario data. 
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9.8 Set Color 
 

 
 
This window is displayed by pressing the "Set Color" button on a window. This 
window allows the user to select a color for the item. The color will be stored as 
a RGB value. 
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